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Basic Documentation – Overview
In addition to the individual program manuals, you will find basic explanations on the operation of the
programs on our homepage www.frilo.com in the Campus-download-section.

https://www.frilo.eu/?lang=en
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Application options

Structural engineers can use the BIM-Connector® with the FRILO programs to
participate in an OpenBIM process. The BIM-Connector® enables the
collaboration between architects and structural engineers, as well as structural
engineers among themselves on a model basis. Any CAD models can be
imported into the BIM-Connector® in the form of an IFC file (Industry
Foundation Classes - IFC 2x3 and IFC4). The Physical Model can then be
converted into an Analytical Model, which can then be transferred to the
FRILO programs. It is also possible to read in SAF files (Structural Analysis
Format) in the BIM-Connector®.

Of the many Model View Definitions from the IFC standard, the BIM-
Connector® primarily processes the Reference View and the Design
Transfer View (= volume representation). The Structural Analysis View (=
Analytical Model in IFC format) is not processed because it is less
developed than the SAF format. A Model View Definition (= MVD) is
essentially a filtered view of the IFC in order to provide the project
participants with the information relevant to them.

The BIM-Connector® was developed with the usual multi-storey building in
solid construction in mind. Framework models will only be considered at a
later point in time.

Your added value:
 Saving of time through direct import of IFC and SAF files
 Thus, more time for the actual structural planning
 Data loss is prevented by direct import
 Manual transmission errors are reduced
 Creation of high quality and precise analytical models
 Direct availability of all relevant data
 Optimized workflow between project participants.
 The export to the design programs PLT Slabs by Finite Elements, B5+ Reinforced Concrete Column and GEO

Building Model (GEO from release 2022-1) are implemented.

System requirements

The BIM-Connector® can run on normal work computers. We recommend these system requirements for
optimal use of the program:

Project size Small and medium-sized models
(e.g. single-family houses)

Big models
(e.g. office complexes)

CPU Intel Core i5, comparable AMD Intel Core i7, comparable AMD

Random access memory 8 GB RAM 16 GB RAM

Hard disk SSD SSD

Graphic card 2 GB VRAM OpenGL compatible
graphic card

4 GB VRAM OpenGL compatible
graphic card

Screen resolution HD/Full HD (1920x1080) HD/ Full HD (1920x1080)

Workflow



Manual FBC

FRILO Software GmbH 19.06.2023 Page 3

Application guide

Program structure

The menu items "File", "1. Physical model "and" 2. Analytical model" are arranged in the ribbon.

File menu

Start with a new item:

Via FileNew (from IFC/SAF) → a new item based on a model link from an IFC or SAF file can be opened.

Start with an already saved position:

Via FileOpen an existing item can be reopened with all changes that have already been saved.

Saving an item:

Via FileSave As you can save an item in the FRILO Control Center FCC.

Note: From Release 2022-1, the BIM connector items are integrated into the FRILO Control Center. The
associated IFC / SAF file is attached to this item as a zipped file and is thus integrated in the
FRILO file management.

Menu items Physical model / Analytical model

A click on “1. Physical model "or" 2. Analytical model" shows the associated command buttons/icons of the
so-called "Ribbon Bar". The program can be operated both via the command button and via the context-
sensitive graphic (right mouse button).

https://www.frilo.eu/wp-content/uploads/EN/Manuals/fcc_eng.pdf
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Physical modell
The physical model is a model that consists of volume elements. This can contain both load-bearing and non-
load-bearing components.

The physical model is opened / imported as an * .ifc file. This model is usually provided by the architect and
usually has to be adjusted (remove objects that are not relevant for the statics, etc.)

The following figure shows a physical model.

Analytical model
The Analytical model, on the other hand, contains all the components required for the static calculation. Thus,
only the load-bearing components are displayed in the Analytical model. The model now only consists of bar
and surface elements. The volume components were reduced to their component axes. The following figure
shows an analytical model.
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Symbols of the Ribbon Bar

The individual program icons are explained below:

All

Single or multiple components can be selected using the
material, the material name, the component name or the
component thickness.

Click the upper half of the icon to select all objects. Click
on the lower half to expand the submenu items. After
selecting a submenu item, a dialog with further options is
displayed.

Isolate

Reduces the display to the selected component.

Hide

Removes the selected components from the display.

All

Cancels all visibility settings again.

Colours

Colours the model according to the material type, material grade, component type, cross-
sections and load.

Norms

Opens a dialog for selecting design standards and materials as default standards.

Material

Assigns a new material to all selected components.

Assigns a new calculated thickness to all selected surface components (walls, ceiling
slabs).

Loads
Assigns a constant load to all selected components (walls/ceilings).

Floor allocation

Allocates all selected components to a target storey or rearranges the entire building.

Non-load-bearing

Marks all selected components as non-load-bearing. Non-load-bearing components do not
appear in the Analytical model.
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Delete

Deletes the marked components permanently from the model.

Load-bearing

Marks all selected components as load-bearing.

About material

Opens a dialog in which the load-transferring components can be specified using a material
selection. In addition, if the “Component thickness” option is selected (check mark),
components can be marked as load-bearing or non-load-bearing according to their
component thickness.

Removes negligible short supports and beams, as well as small openings and small slabs,
from the model.

Straighten
automatically

 Without options:
projects all visible or selected slabs and beams up to an inclination of 2° in the XY plane.

 With options:
projects all visible or selected slabs and beams in the XY plane, whereby components with
a larger angle of inclination can also be taken into account.

 Manually: straightens the first selected slab/beam to the second selected slab.

Join automatically

 Without options:
joins all visible or selected components with one another so that the component edges lie
on top of one another.

 With options:
Automatically joins all selected components, including neighbouring panels that are to be
viewed statically as one panel.

Join manually

 Without options:
extends the first selected part to the second selected part.
a) surface component with surface component, b) line component with surface
component and c) line component with line component.

 With options:
joins selected components, including neighboring panels, which are to be viewed statically
as one panel.

Moves the first selected component in the axis of the second selected component or aligns
a member axis to an edge of a a slab.

Decomposes all selected walls into strips or individual components. As a result, openings in
walls can be taken into account when modeling the Analytical model.

Furthermore, walls can be converted into beam elements.

Converts walls into beams, walls into columns, or beams into walls.

Restores the original wall geometry including all openings.

Checks all or the selected components of the analytical model with regard to unfavorable
component orientation.
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Design / Export
Exports the selected component to the assigned (selectable) FRILO dimensioning program.

Help
Here you can call up the help file or various workflow papers. You can also submit a support
request if you have any questions about the product.

Symbols in the graphics window

 Isometric view [CTRL] + [NUM 1]

 Top view [CTRL] + [NUM 5]

 Front view [CTRL] + [NUM 2]

 View from the side [CTRL] + [NUM 6]

 Measures the distance between two corner points of a component.

 Shows/hides the coordinate system.

 Shows/hides the main dimensions of the building.

 Shows the building in an exploded view.

 Shows/hides the axes/design grid if they are included in the IFC/SAF file.

 Shows/hides the thickness range.

 Highlights the edges when selecting objects.

 Activates/deactivates the section plane function.

Section plane function

A click on the section plane symbol displays a rectangular editing box around the
building. To switch to editing mode, one of the lines in the box must be clicked. This
causes different arrows to appear on all sides of the cube. By moving the arrows in
the plane of the cube or by rotating them around the direction of the arrows, a part
of the model can be cut off.
This allows a view into the interior of the building, e.g. to visually check whether
components are on top of each other.
When the editing mode is activated, the other editing functions are deactivated. By
double-clicking on the cube, a settings dialog for the section plane parameters can
be opened.
Clicking outside the cube exits the editing mode. Now you can continue editing the
model.
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Program operation via shortcuts

In order to be able to work even faster and more efficiently, "Shortcuts" (key combinations for quick access)
were assigned to the most frequently used functions with the R-2023-1 release. A list of all saved shortcuts
can be called up via the "Help" menu item and the "Shortcuts" button.
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Operation basics

In order to achieve good results, some basic working methods are shown below.

The program interface reflects the way the program works. First, an IFC/SAF file is read into the BIM-
Connector®. The structure can then be viewed in the BIM-Connector® and edited accordingly. It can then be
transferred to a program.

IFC-import

The basis for working with the BIM-Connector® is a well-structured architectural model that has already been
reduced to the shell. A shell model is generated from the architectural model, in which the terrain has already
been hidden and, ideally, windows and doors as well as expansion elements or insulation are no longer
available. We therefore recommend that you give the architect a corresponding hint, because the quality of the
Analytical model depends very much on the IFC file on which it is based.

1.) Select File → New (from IFC/SAF)

2.) The Physical model of the imported IFC file of the architect opens

SAF-import

SAF is an Excel-based file format that was developed to improve collaboration between structural engineers.
SAF files are used to exchange data between the structural analysis software from different manufacturers.
The following manufacturers have already implemented the SAF format or are in the process of implementing
it:

FRILO, SCIA, Graphisoft, Allplan (BIMPlus), RISA, Strusoft, Axis VM, Dlubal, Sofistik, SCAD, LIRA land and
Radimpex. More detailed information must be obtained from the relevant software manufacturer.

SAF files transfer ready-made analytical models. The components are imported as bar and surface elements
and the component axes are already connected to one another.

1.) Select File → New (from IFC / SAF)

2.) The Analytical model of the imported SAF file opens

Notes on IFC models

The best results are obtained when the model:

- only includes the shell (e.g. IFC Design Transfer View, IFC Reference View)

- is well structured

- Applicable component types are used (IfcWall, IfcBeam, IfcColumn, IfcSlab, IfcFooting,
IfcRoof, IfcMember)

- A material is assigned to the components (at least the material name)
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Adjust the Physical Model

Colour Material type
Via the ribbon group "Colour" the model can be coloured according to the
material type, the material grade, the component type, the cross-sections
and the load.

The colour display according to the material quality makes it easy to
check whether all components have been assigned a material quality and
whether this corresponds to your own specifications.

The colour representation according to the component type makes it easy
to check whether the correct IFC component type has been assigned to
the components. The BIM Connector currently supports the following IFC
component types:

 IfcWall

 IfcBeam

 IfcColumn

 IfcSlab

 IfcFooting

 IfcRoof

 IfcMember

Material-specific
design standards /
material and quality

Tab for the „Physical
Model“

Visibility Floor allocation

Model structure
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Floor allocation
The floors for calculation can be automatically restructured using the "Floor allocation"
function. From the previous view from "top to bottom", as is usual for architects, the view
from "bottom to top", which is usual for structural engineers, can be generated.

Note: The Model structure can be generated automatically by the program using the
"Floor allocation" function. It is advisable to use the Floor allocation first and
then to manually adapt the Model structure generated afterwards.
Individual components can be moved to another floor using the “Floor allocation” function or with
a right-click “Assign to another floor”.
A clearly structured model achieves better results with the "Join automatically" function.

Model structure
The building can be structured in a meaningful way using the Model structure. Buildings and floors can be
added, deleted and renamed. Components can also be moved to other floors or entire floors to another
building.

Add a new structure:|
To do this, you first have to click on the "Construction project" (first entry in
the structure tree), then the +icon for a new building is activated.

Add a new floor:
To do this, you first have to click on the "Building", then the icon for a new
floor becomes active.

 Add a new building/floor

 Delete building/floor

 Rename project/building /floor

 Floor data dialog

Copy building (with the same structure)

 Moves the floor to another building

 Moves components to another floor

See also FRILO-Insight-2021-2, Restructuring buildings.

Norms / Specifications
The corresponding design standards can be specified using the "Norms" function.

https://www.frilo.eu/wp-content/uploads/EN/PDF/FRILO-Insight-2021-2_EN.pdf
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Non-relevant components – Load transfer
After the IFC/SAF file has been imported, the Physical model should be cleaned of all components that are not
relevant for the calculation. The quickest way to do this is to use the "Load transfer > About material" function
in the "Load transfer" function group. Here, all components relevant for load transfer can be set to "load-
transferring" and all components that are not relevant for load transfer to "non-load transferring".

The checkmark for the component thickness is set by default. Components with a
small component thickness can be identified quickly and set to "non-load-bearing".

Click on the symbol  in the lower area to let the program automatically determine
the load-bearing capacity and the component thickness via the material name.

Note:

In the building model
(GEO), a strip or single
foundation is
automatically applied
under the last load-
bearing component. This
means that strip and
single foundations
contained in the IFC file
must be used as non-load-
bearing components.

All previously marked
objects can be set to non-
load-bearing / load-
bearing using the "non-
load-bearing" or "load-
bearing" icons.

The "Delete" icon can be used to permanently remove all selected objects from the model. It is planned to use
this function to remove objects such as wall layers, floor structure, etc. from IFC files that have not been
cleanly reduced to the shell.

Note:

By deleting components, the performance of the programme can be significantly improved. In particular, the
loading of items is considerably accelerated. Deleted elements can be restored via the corresponding button ,
but this requires saving and re-loading the item. Furthermore, the elements are read in in their original form.

Note on IFC files:

The load-bearing capacity can also already be read out of the IFC file. For this, the attribute "static load-bearing"
must be assigned to the objects in the corresponding CAD program.
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Assign material
The next step is to assign the correct materials and their material grades to the components. With the help of
the various selection and display options (visibility, model structure, etc.), for example, all supports can be
selected in next to no time.

With the help of the "Material" function (Properties), all selected
columns can be assigned the appropriate material with one click.

Behind the button for the material you will find a list of all materials
created for this item. The materials highlighted in yellow and marked
with an asterisk are the standard materials. The standard material grade
is used for all components that have not been explicitly assigned a
different material grade. The standard materials cannot be deleted.

 Adds a new material/material grade.

Opens a dialog for changing the selected material/material
grade.

 Removes the selected material/material grade.

If a material grade has already been assigned to a component and the dialog is subsequently opened again,
the assigned material grade is displayed selected in blue.

Note on IFC files:

The materials and material grades can already be read out of the IFC file. For this, one of the material
designations listed in the following table must be stored in the corresponding CAD programme in the field for
the material (see also workflow paper).

Material Name component Specific material designation

Reinforced
Concrete

„concrete“ Naming scheme:
Cxx/xx bzw. LCxx/xx
e.g. C25/30 or LC20/22
(all common material grades)

Masonry „masonry“
„brick“
„blockwork“
„clinker“
„aerated concrete“
„poroton“
„bisotherm“

Steel „steel“ Naming scheme:

Sxxx

e.g.. S235 (all common material grades)

Timber „timber“
„glulam“
„osb“

(Aluminium) "aluminium" non

If the correct materials have been assigned to all components and the model has been cleared of the non-
load-bearing components, you can switch to the Analytical model. Only the load-bearing components are
shown there.
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Adapt the Analytical model

Via the tab "2. Analytical model ”, the model is finally prepared for the component design.

Calculated thickness
Using the "Thickness" function, surface elements (walls, floors) can be assigned a new calculated thickness.

Loads
To assign a load, the component must first be selected. Then click on the "Load" function.

Assign area loads to a floor slab:

A constant permanent and variable load can be assigned to floor slabs via the
"Loads" function.

Assigning area loads for walls:

By selecting one or more walls, a surface load for the wall plaster (on both sides)
can be added to them. This function can also be found in the GEO and PLT under
the "wall properties".

If the option "Equal plaster load on both sides of the wall" is
activated, the entered load value always refers to the inside and
outside of the wall surface. I.e. the entered load value is
multiplied in the GEO by the total wall area (inside and outside)
and added to the dead weight of the wall.
For this reason, half of the load, i.e. the averaged value, must be
entered in the input field.

Example for wall loads:

Plaster load on both sides: Outside 3 kN/m²
Inside 1.5 kN/m²
(3 kN/m² + 1,5 kN/m²) / 2 wall sides = 2,25 kN/m² per wall side (input value)
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Plaster load on one side: Outside plaster 3 kN/m²
3 kN/m² / 2 wall sides = 1.5k N/m² per wall side (input value)

If there are different load values per side, it is advisable to enter the load value separately. The option can be
deactivated for this purpose. Two input fields then appear. One for the inside and one for the outside of the
wall.

Clean up geometry
The “Clean up geometry” function can be used to clean up negligible small openings, short columns, beams
and small slabs.
The function searches for the components based on the dimensions (length / width / height) or cross-
sectional areas.

The search
can be
started with
the “Start”
button. The
following
dialog then
appears:

The components that meet the criteria for the entered dimensions are displayed and can be removed by
selecting the corresponding line and pressing the "Clean up" button.
Note: Via Ctrl. + A all lines can be selected at once. It is advisable to clean up the model of irrelevant

elements first and only then to use the Join automatically/manually function.
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Straighten
Diagonal beams and slabs could not be transferred to the GEO building model up to
R-2022-2. For this reason, a function was developed to project components (beams and floor
slabs) into the horizontal plane (xy plane).
The "Straighten" function is divided into the areas "Automatic straightening", "Straightening
with options" and "Straightening manually".

Straighten automatically

If you click on the upper part of the button, "automatic straightening" takes place. If no component is selected,
all beams and slabs are projected into the xy plane up to an angle of inclination of 2°.
If beams and slabs are explicitly selected, then these components are always projected into the xy plane,
regardless of the angle of inclination.
The pivot point depends on the nearby slabs. If the algorithm finds an adjacent slab or, in the case of a beam,
a slab above or below it, the point closest to a slab is always searched for and used as the pivot point. If no
slab is found, the highest point of the component to be straightened is automatically used as the pivot point.

Straighten with options

Under "Straightening with options" the inclination angle up to which the components are to be straightened
can be adjusted manually for more inclined beams and slabs.

Straighten manually

The slab/beam selected first can be straightened to the second selected slab using the "Straighten manually"
function.
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Join of component axes / component areas
After deriving the Physical model for the Analytical model, the components are not yet joined together. This is
due to the fact that the components are reduced to their component surfaces/axes, which means that half the
component thickness is always lost. The "Join automatically" function in the "Model editing" group is suitable
for establishing a connection between the components. Depending on the size and complexity of the building,
it is also advisable to use the “Join” function only for the floor under consideration, as a great deal of data is
processed with this function.

Note: The "Join" function achieves better results with a clearly structured building that has been cleared of non-
load-bearing and irrelevant elements.

During the joining, all selected/visible components are combined in pairs.

No components are moved in the process. The components are only lengthened in
their area and axis until they meet another component that is in the vicinity. The plate
contour is aligned with the walls and beams.

If the components are not joined as desired, a user-defined value can be entered for
the “Limit factor connection distance” which you will find when “Join automatically
with options”.

The elements merged into a pair are only connected if their distance is small and the user-defined distance
limit is not exceeded. It is advisable to set the limit factor greater than
0.50. If the value of the limit factor is too high, if there are many
components to be connected, this can lead to the undesired effect that
elements that do not belong together are blended.

Joining automatically with options / adjacent slabs

If two adjacent slabs are to be used statically as a common slab, the
"Join automatically with options" function is available. The option “Join
adjacent slabs” can be selected here so that they are also
automatically joined. It is necessary to specify a maximum horizontal
slab distance at which the slabs can still be joined. The distance between the slabs must be entered in
centimetres. This function only applies to slabs that lie in the same horizontal plane. For slabs with different
slab thicknesses, thickness ranges are automatically created when joining.

Note: If not all components were connected to one another with "join automatically", it is advisable to
select the components that are not connected and to connect the components using the "Join
automatically - with options" function. The limit factor can be increased accordingly.

Joining manually

Manual post-processing is sometimes necessary when joining the components. The “Join manually” function
is available for this. With this function, the first selected component is always joined to the second selected
component or the first selected components to the last selected component. In contrast to the “Join
automatically” function, no limit distance is used for “Join manually”. This means that components can also
be connected which are far apart and which were not recorded by the "Join automatically" option. In contrast
to the "Join automatically" function, the merging of adjacent slabs, which are vertically offset to one another,
is possible with the "Join manually" function.

This function can also be used to influence the order in which the components are to be connected to one
another.

Note: Several components can be selected using the "Ctrl" key.

Note: In the GEO Building Model, only one ceiling can be modeled per floor. In order to obtain a correct
floor division in the GEO, slabs “must” be connected within a floor in the BIM-Connector or set to
non-load-bearing.
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Joining types / components

The "Join" function is offered both for surface components such as walls and ceiling slabs, as well as for line
components such as columns and beams, which are represented in the static calculation by surfaces and
frameworks.

Three types of joining are supported:

1) surface component with surface component,

 Walls with one another: walls that extend to their component axis (example below) or walls that are
at a certain angle to one another can be joined.

 Ceilings with one another: ceilings with the same component thickness and ceilings with different
component thicknesses can be joined. In this case, a thickness area is created. So that the floors can
be joined, they must run parallel to each other.

 Walls and ceilings

2) line component with surface component

 Beams with walls: the wall must be at a certain angle to the beam. Walls that are in the extension of
the beam axis cannot currently be joined with beams.

 Columns can be joined with floor slabs

3) line component with line component.

 Beams with columns/columns with beams (example below)
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Examples
Joining line component with line component

You can see the Analytical model of a ceiling slab with edge joists (picture on the left). The components are
not joined and can be joined using the “Join manually” function. The column can first be extended up to the
beams (middle picture). To do this, the column is selected first, then one of the two beams. Then the beams
have to be extended up to the support (picture on the right). Therefore, the two beams are selected first, then
the column. The components are always extended to the last selected component.

Joining of walls

Two wall elements can always be selected by pressing the "Ctrl" key and joined using the "Join manually"
function. In the left picture four individual wall sections can be seen, in the right picture a continuous wall is
shown.
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Relate opening to wall axis or beam axis

The following picture shows the physical model of a floor from below. This rests on three walls. The analytical
model for the same situation can be seen in the middle picture. It becomes clear that the opening is not
related to the axes of the walls. This can be adjusted later using the "Join manually" function. To do this, the
opening must first be selected, then the corresponding wall to which the opening is to be related with the "Ctrl"
key pressed. Then the function is selected and the opening is related to the axis of the wall (picture on the
right).

Note: components lying in the background can be selected by holding down the "Ctrl" key and using the
mouse's scroll wheel.

Fig .: With a "right click" on an opening, openings (both in walls and ceiling tiles) can be removed.
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Align the slab edge with the end of the wall

During the automatic joining, the panel contour was not related to the wall end of wall 1. In some cases,
however, this may be desirable. The function “Join manually”  “Align panel edge to wall end” is available for
this purpose. This function can be found in the drop-down menu of the “Join manually” function. In order to
adapt the geometry accordingly, the plate must first be selected, then the right edge of wall 1. Then the
function can be carried out. The edge of the plate is aligned with the exact end of the wall that is closest to the
click position when selecting the wall.

Move members
When moving members, first click on the first component that is to be
moved, then press the Ctrl key and then click on the second component.
Then select one of the two move functions:

… Member to member

You can use this function to move the component selected first into the axis of the second component
selected.

… Member at panel edge

The component selected first is moved to the edge of the slab/panel selected second.

When clicking the (second) slab, please pay attention to the click position. The edge of the slab to which the
(first) component is moved is determined by the click position in the (second) slab selection - it is therefore
moved to the edge of the slab/panel that is closest to the click position.

Tip: Zoom in on the corresponding components (mouse wheel, zoom functions under "Graphics" in the
top menu). You can rotate the system with pressed right mouse button.
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Disassemble walls
With the function “Disassemble walls” and “… into individual members”, either all walls
can be edited at once or only the selected walls can be edited in different ways
according to their openings. This means that existing openings can be taken into
account in the Analytical model.

Click the top half of the icon to disassemble all of the walls at once.

Click on the lower half of the symbol to expand the submenu items and to split the
previously marked / clicked wall into wall strips or individual components.

Disassemble walls into wall strips

This function splits the wall into strips according to the openings. In the
program Slabs with Finite Element PLT and Building Model GEO, no support is
modeled at these points.

Disassemble walls into individual members

This function enables the walls to be automatically disassembled into individual components. Areas above
openings are automatically converted into beam elements. When handing over to PLT / GEO, the area above
an opening is passed over as an downstand beam. In the dialog that appears, you have the option of removing
narrow pillars and small openings with this function.

This function enables walls to be converted into beam elements. For example, if an attic was modeled as a
wall in the CAD program, it can be converted into beam elements.

Fig .: A wall with 4 openings (left) was disassembled into wall strips/individual components (right).

The "Undo" function restores the original wall geometry.
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Conversion
For the conversion function, the corresponding component must first be selected, then
the function must be used. Various conversion functions are available:
The "Conversion into beam/girder" function enables walls to be converted into beam
elements. For example, if a parapet was modeled as a wall in the CAD program, it can
be converted into beam elements.

The "… wall into column" function enables walls to be converted into columns.

The “… beams/girders into wall” function enables beams to be converted into walls.

Check model
This function can be used to check the model for an unfavorable component orientation. The model can
be checked for alignment in the vertical direction and for alignment in the horizontal direction. The check
model function should be used before exporting.

Vertical direction

When checking in the "vertical direction", the components of one
floor are compared with those of the floor below. It is checked
whether the deviation of the component axes to be compared lies in
the range defined by the minimum and maximum distance. The
component axes between wall-beam, wall-wall and beam-beam are
checked. If the option "Check columns only against other columns"
is selected, a check is made as to whether the component axes of
columns are on top of each other across floors.

Horizontal direction

When checking in the "horizontal direction", on the one hand the
distances between the components in relation to the slab are
examined. So: slab-wall, slab-beam, slab-column.
In addition, the component axes within a floor are compared with
one another. It is checked whether the deviation of the component
axes to be compared lies in the range defined by the minimum and
maximum distance. In contrast to the vertical inspection, the axes
within a floor are compared with one another. The axes between wall-beam, wall-column, beam-column, wall-
wall, beam-beam are checked.
If the option "Check columns only against other columns " is selected, a check is made as to whether the
columns are parallel to each other.
Note: For the sake of clarity, the horizontal inspection of large buildings with several floors can also be

carried out separately for individual floors.

Since only one slab can be modeled and transferred to the GEO Building Model and PLT slab program per
floor, the "Check model" function also searches for unconnected slabs within a floor.
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Export to the design programs PLT, B5 +, GEO
Export to B5 +
By selecting walls and columns, these components can be transferred to the B5+
reinforced concrete column program.

Export to PLT
By selecting a slab, a single slab can be transferred to the PLT slab program.

Export to GEO
Individual floors can be exported to GEO. Various export options are available:
 If one slab has been selected, it is transferred to the PLT. All components that lie within the slab contour are

also transferred. Components that lie outside the slab contour are not transferred.

 If two or more slabs have been selected, they are transferred to the GEO. All components that lie within the
slab contour and any additionally selected components that can also lie outside the panel contour are also
transferred.

 If no component was selected, the entire building is transferred to the GEO - including components that are
outside the slab contour.

 Only visible floors/buildings are transferred.

Note: After the export, the entire building model should be

- completeness of the components

- component dimensions

- positioning

- static effect

- material allocation

- support

- bedding module of the base slab

be checked!

Note: After the export, use the various 3D views for visual inspection.

Note: In order to obtain a correct floor division in the GEO building model, slabs within a floor must be
connected in the FBC or set to non-load-bearing.

Note: Since no foundations have to be entered as individual components in the GEO Building Model, the
individual and strip foundations should be marked as non-load-bearing components.

Export of buildings with differences in height or multiple building towers with one common basement

For a building with height differences, the slabs should be connected to each other before exporting it. Slabs
with the same slab thickness can be connected in FBC via the “Connect manually” function. The first selected
slab is automatically moved to the height of the second selected slab and connected to it at this height level.
Even slabs with different slab thicknesses can be connected using the “Connect manually” function. In this
case, a thickness region is also created for the first selected slab, however. After exporting the data to the
Building Model, you should take a detailed look at the transition area. If necessary, an additional beam and/or
a slab joint must be inserted here. See also FRILO Insight 2/2022, page 8.

https://www.frilo.eu/wp-content/uploads/EN/Manuals/fl_b5_eng.pdf
https://www.frilo.eu/wp-content/uploads/EN/Manuals/geo_eng.pdf
https://www.frilo.eu/wp-content/uploads/EN/Manuals/plt_eng.pdf
https://www.frilo.eu/wp-content/uploads/EN/PDF/FRILO-Insight/FRILO-Insight-02-22.pdf
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Selection of objects/components with the mouse

To assign a material to components, for example, you must select the relevant
components. To do this, you can, drag an area over the components to be
selected in the graphic with the mouse. The selected components are now
highlighted in color.

Tip:  You can switch off the "visibility" of components, materials and properties
using the options area on the left, so that only those elements that you
want to change/edit are displayed in the graphic for selection.
You can also hide, edit, add or delete individual floors and buildings via
the “model structure”.

Multiple selection with a click of the mouse

To select several individual elements, hold down the "Ctrl" key and click the
desired elements with the mouse.

The function groups Selection and View in the ribbon bar offer further convenient
options.

Note: components lying in the background can be selected by holding
down the "Ctrl" key and using the mouse's scroll wheel.

Rotate building

The building can be rotated by holding down the right mouse button. The central
axis of the building is set as the pivot point. If a component is selected, the pivot
point is reset. The selected component is set as the new pivot point for the entire
building until the selection is canceled or a new component is selected.

Zooming

As an alternative to the zoom functions (magnifying glass symbols in the top menu), you can also zoom using
the mouse wheel.
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FAQ

Which FRILO programs are linked to the BIM-Connector®?
In the 2021-1 release, the BIM-Connector® is connected to the PLT Slabs by Finite Elements and the
B5+.Reinforced Concrete Column. Since Release 2022-1 the GEO Building Modell interface is also
implemented.

Do you want to connect other programs to the BIM-Connector®?
In the following releases the DLT+ Continuous Beam, Framework RSX and the masonry programs will also be
connected.

Which file formats can the BIM-Connector® read in?
The BIM-Connector® can read in both IFC files (IFC 2x3 and IFC4) and SAF files.

Which settings when exporting the IFC models from a CAD program favor the import into
the BIM-Connector® FBC?
The best results are achieved when the generated IFC file
- only includes the shell (e.g. IFC Design Transfer View, IFC Reference View)
- is well structured
- applicable component types are used (IfcWall, IfcBeam, IfcColumn, IfcSlab, IfcFooting, IfcRoof, IfcMember)
- a material is assigned to the components (at least the material name)
- based on volume geometries that are not too complex (e.g. separate volume description for each wall
instead of a single volume for all walls)

How is an analytical model derived from the physical model?
The components are reduced to their system axes. Volume elements are reduced to bar and surface
elements.

Can slabs with different thickness ranges be transferred to the PLT/GEO?
Slabs with different component thicknesses can be connected using the function "Join manually"; this slab
with its thickness range is transferred to the PLT/GEO programs.

Can openings in walls be taken into account?
Walls can be disassembled into strips. When exporting to the PLT panel program, no support is generated at
these points. The openings in the FBC are extended over the entire height of the storey.
The wall can also be disassemled into individual components. A beam is then automatically created over an
opening.

Why are wall openings not transferred to the GEO Building Model / PLT Slabs program?
In order for wall openings to be transferred, the walls must first be edited using the "Disassemble walls"
function. Walls can be disassembled into strips or individual components. In the area above an opening, either
a beam or no support is transferred to GEO/PLT.
Note: Walls in which openings have been modeled up to the ceiling must also be edited.

Can the BIM-Connector® also read IFC analytical models?
No, not yet. At the moment only IFC files with physical elements and SAF files can be read.

Why are some components not read in or not displayed exactly like the original?
When reading in complex component geometries, we undertake a certain abstraction. If the original geometry
is too complex, noticeable deviations can occur here. As a rule, however, the deviations are minimal. We are
constantly trying to refine and improve our algorithms. However, the focus is on the components, which we
can also measure.
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Why are items missing from my file?
If components are missing, the components were either modeled with unsupported component types or the
"IfcBuildingElementProxy" element type was used. IfcBuildingElementProxy elements are geometric
placeholders with no information on the function. For example, if a wall was modeled from
IfcBuildingElementProxy elements, "the wall does not know that it is a wall". If the wall were to be converted
into an IfcWall component, it would also be recognized by the BIM-Connector® as a wall and thus displayed.
The BIM-Connector® currently supports the following IFC component types:

 • IfcWall
 • IfcBeam
 • IfcColumn
 • IfcSlab
 • IfcFooting
 • IfcRoof
 • IfcMember

Why does the FRILO BIM-Connector® need higher system requirements than the other
FRILO programs?
The BIM-Connector® processes a lot of CAD data. As a result, it is very resource-hungry and requires certain
system resources to smoothly display complex models

Can component thicknesses be adjusted in the BIM-Connector®?
Currently, the calculated thickness of ceiling tiles and walls can be adjusted. Advanced settings will follow.

Why is a different floor distribution / an incorrect floor distribution transferred to the
GEO building model?
Since only one ceiling can be modeled per floor in the Building Model, the BIM-Connector® can only transfer
one ceiling per floor. Unconnected slabs are each pushed into a separate floor.
Therefore, before exporting, several slabs should be joined to one another within one storey or set to non-load-
bearing.
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